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Chapter 453

Superiority by a
Margin Tests for the
Ratio of Two Means
Introduction
This procedure calculates power and sample size for superiority by a margin t-tests from a parallel-groups design in
which the logarithm of the outcome is a continuous normal random variable. This routine deals with the case in
which the statistical hypotheses are expressed in terms of mean ratios instead of mean differences.
The details of testing the superiority (or non-unity null) hypothesis of two treatments using data from a two-group
design are given in another chapter and they will not be repeated here. If the logarithm of the response can be
assumed to follow a normal distribution, non-unity null hypotheses stated in terms of the ratio can be transformed
into hypotheses about the difference. The details of this analysis are given in Julious (2004). They will only be
summarized here.

Superiority Testing Using Ratios
It will be convenient to adopt the following specialized notation for the discussion of these tests.
Parameter

PASS Input/Output Interpretation

µT

Not used

Treatment mean. This is the treatment mean.

µR

Not used

Reference mean. This is the mean of a reference population.

Ms

SM

Margin of superiority. This is a tolerance value that defines the
magnitude of difference that is required for practical importance. This
may be thought of as the smallest difference from the reference that is
considered to be different.

Parameter

PASS Input/Output Interpretation
R1
True ratio. This is the value of φ = µT / µ R at which the power is
calculated.

φ

Note that the actual values of µT and µ R are not needed. Only the ratio of these values is needed for power and
sample size calculations.
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The null hypothesis of non-superiority is

H 0 :φ ≤ φL whereφL > 1.
and the alternative hypothesis of superiority is

H1: φ > φL

Log-Transformation
In many cases, hypotheses stated in terms of ratios are more convenient than hypotheses stated in terms of
differences. This is because ratios can be interpreted as scale-less percentages, but differences must be interpreted
as actual amounts in their original scale. Hence, it has become a common practice to take the following steps in
hypothesis testing.
1. State the statistical hypotheses in terms of ratios.
2. Transform these into hypotheses about differences by taking logarithms.
3. Analyze the logged data—that is, do the analysis in terms of the difference.
4. Draw the conclusion in terms of the ratio.
The details of step 2 for the null hypothesis are as follows.

φL ≤ φ
µ 
⇒ φL ≤  T 
 µR 
⇒ ln(φL ) ≤ {ln( µT ) − ln( µ R )}
Thus, a hypothesis about the ratio of the means on the original scale can be translated into a hypothesis about the
difference of two means on the logged scale.

Coefficient of Variation
The coefficient of variation (COV) is the ratio of the standard deviation to the mean. This parameter can be used
to represent the variation in the data because of a unique relationship that it has in the case of log-normal data.
Suppose the variable X is the logarithm of the original variable Y. That is, X = ln(Y) and Y = exp(X). Label the
mean and variance of X as µ X and σ X2 , respectively. Similarly, label the mean and variance of Y as µY and σ Y2 ,
respectively. If X is normally distributed, then Y is log-normally distributed. Julious (2004) presents the following
well-known relationships between these two variables

 µX +σ X 
2 
µY =  e



2

(

)

σ Y2 = µY2 eσ − 1
2
X

From this relationship, the coefficient of variation of Y can be found to be

COVY =

(

)

µY2 eσ − 1
2
X

µY
σ X2

= e

−1
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Solving this relationship for σ X2 , the standard deviation of X can be stated in terms of the coefficient of variation
of Y. This equation is

σ X = ln(COVY2 + 1)
Similarly, the mean of X is

µX =

(

µY

)

ln COVY2 + 1

One final note: for parallel-group designs, σ X2 equals σ d2 , the average variance used in the t-test of the logged
data.
Thus, the hypotheses can be stated in the original (Y) scale and then the power can be analyzed in the transformed
(X) scale.

Power Calculation
As is shown above, the hypotheses can be stated in the original (Y) scale using ratios or the logged (X) scale
using differences. In either case, the power and sample size calculations are made using the formulas for testing
the difference in two means. These formulas are presented in another chapter and are not duplicated here.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the means, sample sizes, alpha, and
power.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. In most situations, you will select
either Power or Sample Size (N1).

Test
Higher Means Are
This option defines whether higher values of the response variable are to be considered better or worse. The
choice here determines the direction of the test.
If Higher Means Are Better the null hypothesis is R ≤ 1+SM and the alternative hypothesis is R > 1+SM. If
Higher Means Are Worse the null hypothesis is R ≥ 1-SM and the alternative hypothesis is R < 1-SM.
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Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
non-superiority when in fact the treatment mean is superior.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when rejecting the null hypothesis of nonsuperiority when in fact the treatment group is not superior to the reference group.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N1, solve for N2
Select this option when you wish to fix N1 at some value (or values), and then solve only for N2. Please note
that for some values of N1, there may not be a value of N2 that is large enough to obtain the desired power.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.
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N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1, solve for N2”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.
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•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
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Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.

Effect Size – Ratios
SM (Superiority Margin)
This is the magnitude of the margin of superiority. It must be entered as a positive number.
When higher means are better, this value is the distance above one that is required for the mean ratio (Treatment
Mean / Reference Mean) to be considered superior. When higher means are worse, this value is the distance
below one that is required for the mean ratio (Treatment Mean / Reference Mean) to be considered superior.
Note that the sign of this value is ignored. Only the magnitude is used.
Recommended values:0.20 is a common value for this parameter.
R1 (True Ratio)
This is the value of the ratio of the two means (Treatment Mean / Reference Mean) at which the power is to be
calculated.
When higher means are better, this value should be greater than 1+SM. When higher means are worse, this value
should be less than 1-SM.

Effect Size – Coefficient of Variation
COV (Coefficient of Variation)
The coefficient of variation is the ratio of the standard deviation and the mean (SD/Mean). It is used to specify the
variability (standard deviation). Note that this COV is defined on the original (not logarithmic) scale. This value
must be determined from past experience or from a pilot study.
To be clear, consider the following definition. Suppose data on a response variable Y are collected. This
procedure assumes that the values of X = Ln(Y) are analyzed using a two-sample t-test. Thus, there are two sets
of means and standard deviations: those of X labelled MX and SX and those of Y labelled MY and SY. The COV
entered here is the COV of Y = SY/MY. For log-normal data, the following relationship exists: COV(Y) =
SQR(Exp(SX*SX)-1) where SX is the standard deviation of the log-transformed values.
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Example 1 – Finding Power
A company has developed a drug for treating rheumatism and wants to show that it is superior to the standard
drug by a certain amount. Responses following either treatment are known to follow a log normal distribution. A
parallel-group design will be used and the logged data will be analyzed with a two-sample t-test.
Researchers have decided to set the margin of superiority at 0.20. Past experience leads the researchers to set the
COV to 1.50. The significance level is 0.025. The power will be computed assuming that the true ratio is either
1.30 or 1.40. Sample sizes between 100 and 1000 will be included in the analysis.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for the Ratio of Two Means procedure window by expanding
Means, then Two Independent Means, then clicking on Superiority by a Margin, and then clicking on
Superiority by a Margin Tests for the Ratio of Two Means. You may then make the appropriate entries as
listed below, or open Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Higher Means Are ................................... Better
Alpha ....................................................... 0.025
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 100 to 1000 by 100
SM (Superiority Margin) .......................... 0.2
R1 (True Ratio) ....................................... 1.3 1.4
COV (Coefficient of Variation) ................ 1.5

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Superiority Test (H0: R ≤ 1 + SM; H1: R > 1 + SM)
Higher Means are Better
Test Statistic: T-Test
H0 (null hypothesis) is that R ≤ 1 + SM, where R = Treatment Mean / Reference Mean.
H1 (alternative hypothesis) is that R > 1 + SM.
Power
N1
0.07477
100
0.11039
200
0.14493
300
0.17994
400
0.21389
500
0.24762
600
0.28099
700
0.31390
800
0.34624
900
0.37791
1000
0.16832
100
0.29339
200
(report continues)

N2
100
200
300
400
500
600
700
800
900
1000
100
200

N
200
400
600
800
1000
1200
1400
1600
1800
2000
200
400

Bound
(SB)
1.200
1.200
1.200
1.200
1.200
1.200
1.200
1.200
1.200
1.200
1.200
1.200

SM
0.200
0.200
0.200
0.200
0.200
0.200
0.200
0.200
0.200
0.200
0.200
0.200

R1
1.3000
1.3000
1.3000
1.3000
1.3000
1.3000
1.3000
1.3000
1.3000
1.3000
1.4000
1.4000

COV
1.5
1.5
1.5
1.5
1.5
1.5
1.5
1.5
1.5
1.5
1.5
1.5

Alpha
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
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Report Definitions
Power is the probability of rejecting a false null hypothesis.
N1 and N2 are the number of items sampled from each population.
N is the total sample size, N1 + N2.
SM is the magnitude of the margin of superiority. Since higher means are better, this value is positive and is
the distance above one that is required to be considered superior. SB is the corresponding bound to the
superiority margin, and equals 1 + SM.
R1 is the mean ratio (treatment/reference) at which the power is computed.
COV is the coefficient of variation on the original scale.
Alpha is the probability of rejecting a true null hypothesis.
Summary Statements
Group sample sizes of 100 in the first group and 100 in the second group achieve 7% power to
detect superiority using a one-sided, two-sample t-test. The margin of superiority is 0.20. The
true ratio of the means at which the power is evaluated is 1.30. The significance level (alpha)
of the test is 0.02500. The coefficients of variation of both groups are assumed to be 1.50.

This report shows the power for the indicated scenarios.

Plots Section
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These plots show the power versus the sample size for two values of R1.
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Example 2 – Validation
We could not find a validation example for this procedure in the statistical literature. Therefore, we will show that
this procedure gives the same results as the non-zero null test on differences—a procedure that has been validated.
We will use the same settings as those given in Example 1. Since the output for this example is shown above, all
that we need is the output from the procedure that uses differences.
To run the non-zero null test on differences, we need the values of SM and S1.

(
)
ln(15
. + 1)

S1 = ln COV 2 + 1
=

2

.
= 1085659

SM ' = ln(1 + SM )
= ln(1.2 )
= 0.182322

D = ln(R1)
= ln(1.3)
= 0.262364

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for the Difference Between Two Means procedure window
by expanding Means, then Two Independent Means, then clicking on Superiority by a Margin, and then
clicking on Superiority by a Margin Tests for the Difference Between Two Means. You may then make the
appropriate entries as listed below, or open Example 1b by going to the File menu and choosing Open Example
Template.
Option

Value

Design Tab
Solve For ................................................ Power
Higher Means Are ................................... Better
Nonparametric Adjustment ..................... Ignore
Alpha ....................................................... 0.025
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 100 to 1000 by 100
SM (Superiority Margin) .......................... 0.182322
D (True Difference) ................................. 0.262364
S1 (Standard Deviation Group 1) ........... 1.085659
S2 (Standard Deviation Group 2) ........... S1
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Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Superiority Test (H0: Diff ≤ SM; H1: Diff > SM)
Higher Means are Better
Test Statistic: T-Test
Power
0.07477
0.11039
0.14493
0.17994
0.21389
0.24761
0.28099
0.31390
0.34624
0.37790

N1
100
200
300
400
500
600
700
800
900
1000

N2
100
200
300
400
500
600
700
800
900
1000

N
200
400
600
800
1000
1200
1400
1600
1800
2000

SM
0.182322
0.182322
0.182322
0.182322
0.182322
0.182322
0.182322
0.182322
0.182322
0.182322

D
0.262364
0.262364
0.262364
0.262364
0.262364
0.262364
0.262364
0.262364
0.262364
0.262364

S1
1.085659
1.085659
1.085659
1.085659
1.085659
1.085659
1.085659
1.085659
1.085659
1.085659

S2
1.085659
1.085659
1.085659
1.085659
1.085659
1.085659
1.085659
1.085659
1.085659
1.085659

Alpha
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025

You can compare these power values with those shown above in Example 1 to validate the procedure. You will
find that the power values are identical.
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